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TLE / QUARTER 1/ GRADE 7 

I. CURRICULUM CONTENT, STANDARDS, AND LESSON COMPETENCIES      

A. Content 

Standards 

The learners demonstrate an understanding of using productivity software 

B. Performance 

Standards  

The learners perform the utilization of productivity tools in a safe and responsible manner 

C. Learning 

Competencies  
and Objectives

  

Learning Competency 

The learners shall be able to create presentations with hyperlinks and action buttons 
 

Learning Objectives 
At the end of the lesson, the learners shall be able to:  

1.   create a presentation using hyperlinks and action buttons 

D. Content Presentation Software 

● Hyperlinks 

● Action Buttons 

E. Integration SDG 4: Quality Education  
SGD 9: Industry, Innovation and Infrastructure 

 

II. LEARNING RESOURCES 

Action Buttons. (n.d.). GCFGlobal.org. https://edu.gcfglobal.org/en/powerpoint/action-buttons/1/  

Add hyperlinks to slides. (n.d.). https://support.microsoft.com/en-us/office/add-a-hyperlink-to-a-slide-239c6c94-d52f-480c-99ae-

8b0acf7df6d9  

Hyperlinks. (n.d.). GCFGlobal.org. https://edu.gcfglobal.org/en/powerpoint2016/hyperlinks/1/ 

Writtenhouse, S. (2022c, October 21). How to create action buttons in Microsoft PowerPoint. How-To 

Geek. https://www.howtogeek.com/834212/how-to-create-action-buttons-in-microsoft-powerpoint/  

 

 

https://edu.gcfglobal.org/en/powerpoint/action-buttons/1/
https://support.microsoft.com/en-us/office/add-a-hyperlink-to-a-slide-239c6c94-d52f-480c-99ae-8b0acf7df6d9
https://support.microsoft.com/en-us/office/add-a-hyperlink-to-a-slide-239c6c94-d52f-480c-99ae-8b0acf7df6d9
https://edu.gcfglobal.org/en/powerpoint2016/hyperlinks/1/
https://www.howtogeek.com/834212/how-to-create-action-buttons-in-microsoft-powerpoint/
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III. TEACHING AND LEARNING PROCEDURE NOTES TO TEACHERS 

A. Activating Prior 

Knowledge 
 

 

 

DAY 1 

1. Short Review 
Ask students to answer the following: 

1. What are the seven (7) rules in creating a presentation? 

2. What is a Master Slide? 

2. What is the function of Motion Paths? 

3. What is the importance of the Animation Pane? 

2. Feedback (Optional) 

 

 
 

 

 

B. Establishing 

Lesson Purpose 

1. Lesson Purpose  

Ask the students the following questions: 

1. What did you notice in the presentation? 

2. What particular feature is in the presentation that enables a user to jump 

from one slide to another without following the order of the slides. 

3. Do you find this feature helpful in achieving an effective presentation? 

 

2. Unlocking Content Vocabulary 

Hyperlink - A hyperlink is a link added to a text or image that, when clicked, takes the 

user to a new page or document. 
Action Button – it is an object on a slide that performs action when clicked such 

as jumping to another slide or document. 
 

Show a sample presentation 

with hyperlinks and action 
buttons to the students. Ask 

them the questions. 
 

Today, we’ll learn how to make 

our presentations more 
interactive using hyperlinks 

and action buttons. Think of 
these tools as ways to guide 

your audience through your 
story, allowing them to explore 

different parts of your 
presentation seamlessly. 

C. Developing and 

Deepening 
Understanding 

SUB-TOPIC: 1 – Hyperlinks 

 

1. Explicitation 

Whenever you use the Internet, you use hyperlinks to get from one webpage to 

another. To make it easier for people to click on a web URL or email address you 

offer in your PowerPoint presentation, you may format it as a hyperlink. It' is 

also possible to link to files and other slides within a presentation. You can link 

to a webpage, or to a new document or a place in an existing document. 

 

 
Ask these questions to 

students: 
 

1. What are some instances 
where you might use a 

hyperlink in your presentation? 
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At the end of this lesson, you shall be able to use Hyperlink command in order 

to link a slide to files and other slides within a presentation, and also link to a 

webpage, a new document or existing document or an e-mail address. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Worked Example 

Guided Practice:  

● Link to a website: 
1. Select the text, shape, or picture that you want to use as a hyperlink to 

make it active. 
2. Go to Insert tab from the Ribbon and from the Links group, click Link 

3. The Insert Hyperlink dialog box will appear.  
4. Select Existing File or Web Page, and add the: 

▪ Text to display: Type the text that you want to appear 
as hyperlink. 

▪ ScreenTip: Type the text that you want to appear when the user 

hovers over the hyperlink. This is optional 

▪ Current Folder, Browsed Pages, or Recent Files: From the list, 

select the file where you want to link to. 

2. How can action buttons 
improve the user experience in 

your presentation? 
 

 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

Before you give the activity to 

the students, you must first 
discuss the following: 

1.  

1. Activity Title: Using 

Hyperlink 

2. Materials needed: 

Computer and Microsoft 

PowerPoint presentation or 

other presentation software 

3. Objective: To create a 

presentation with hyperlink 

4. Instructions 
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▪ Address: If you have not selected a location and file above, type or 
insert the URL for the web site or for the file you want to link to. 

▪ Select OK. 
 

● Link to a place in a document, new document, or email address 

1. Select the text, shape, or picture that you want to use as a hyperlink to  

make it active. 
2. Go to Insert tab from the Ribbon and from the Links group select Link. 

The Insert Hyperlink dialog box will appear. 
▪ Place in This Document: Link to a specific slide in your 

presentation. 
▪ Create New Document: Link from your presentation to another 

presentation. 
▪ E-mail Address: Link a displayed email address to open up a 

user's email program. 

3. Fill in the Text to display, ScreenTip, and select or insert the slide, file 
or e-mail address where you want to link to. 

4. Select OK. 
 

● Change the color of a hyperlink 

Most hyperlink color is blue, but 
you can change the color if you like.  

1. Select the hyperlink (text) that 

you want to re-color. 
2. On the Home tab of the Ribbon, 

select down arrow next to 
the Font Color button to open 

the menu of colors. 
3. Select the color you want for the 

hyperlink. You will see the new 

color to the hyperlink. 
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● Test the hyperlink 

Once you are done inserting the link, you can 
test it (in Normal view) by right-clicking the 

hyperlink and selecting Open Link. 
 

 

 
 

 
 

 
 

DAY 2 

3. Lesson Activity 

Instructions:  

1. Open the PowerPoint presentation with the filename: “My Presentation”. 

2. The presentation should have at least 10 slides. 

3. Make sure that the slides have appropriate images, shapes or graphics to 

compliment the presentation. 

4. Select a text or image in a slide and link it to a webpage. The text or image 

must be related to the content of the webpage you will link to.  

5. Put the appropriate label for the Text to Display and Screen Tip Text for 

that link. 

6. Select a text or image in a slide and link it to an existing file. The text or 

image must be related to the content of the file you will link to. 

7. Put the appropriate label for the Text to Display and Screen Tip Text for 

that link. 

8. Select a text or image in a slide and link it to a slide within your 

presentation. Make sure that the content of the two slides are related. 

9. Put the appropriate label for the Text to Display and Screen Tip Text for 

that link. 

10. Select a text or image in a slide and link it to an e-mail address. 

11. Put appropriate label for the Text to Display and Screen Tip Text for that 

link. 
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12. Format your presentation as needed.  

13. Make sure to always apply the 7 rules in creating a presentation when 

formatting and finishing your presentation. 

14. Use the “Save As” command to save your work and use “My Link” as the 

filename. You should now have a new presentation file. 

 

DAY 3 
SUB-TOPIC: 2 – Action Buttons 

 
1. Explicitation  

    A PowerPoint presentation can be made more interactive and user-friendly for 

the audience by adding Action Buttons to the slides. These buttons can make 
the presentation easier to browse and give the impression that the slides are web 

sites. 
    Think carefully about how your audience will use your PowerPoint 

presentation before adding action buttons. Should the action buttons take up a 
large amount of space at the bottom or side of the slides, or should they be 

clearly visible? 
    How will the buttons be used by the audience? and will using action buttons 

for navigation simply make the point of your presentation clearer?  

    After you have the answers to these questions, you may incorporate action 
buttons into your presentation with the confidence that the viewer will benefit 

rather than become confused. 

 

2. Worked Example 

Guided Practice: 

● Adding Action Button 

1. Select the slide where you would like to insert the Action Button. 

2. Go to the "Insert" tab from the Ribbon and select the "Shapes" drop-

down arrow. At the bottom of the list, you will see the options for Action 
Buttons. 

3. Select the one that best matches the action you want to perform. 

4. When your cursor changes to a crosshair symbol, use it to drag and draw 

the shape to the slide.  

 
 

 
 

 

 
Before introducing today’s 

lesson, you may first have a 
review of the knowledge and 

skills they have gained from the 
previous lesson.  

 
Gather students’ ideas by 

asking them the questions. 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 

 
 

 
 

 
 

https://www.howtogeek.com/428396/how-to-draw-and-edit-a-freeform-shape-in-microsoft-powerpoint/
https://www.howtogeek.com/428396/how-to-draw-and-edit-a-freeform-shape-in-microsoft-powerpoint/
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5. If needed, you can also resize the button by dragging a corner or edge. 

6. Once you draw the action button, the "Action Settings" box 

automatically appears. 
7. Use the "Mouse Click" tab to 

assign an action for when 

you click the button. Or, use 
the "Mouse Over" tab to 

assign an action for when 
you hover your cursor over 

it. 
8. You can choose to hyperlink 

the button, trigger a 

program, run a macro, or 
use an object linking and 

embedding (OLE) object 
action. 

● Hyperlink To: Use 
the drop-down list to select what you would like to link to, such 

as the next slide, last slide, a custom show, URL, or file. 
● Run Program: Use the "Browse" button to select the program you 

want to open. 

● Run Macro: Use the drop-down box and select a macro from the 
list. If you do not have any macros in the presentation, this option 

is in gray mode. 
● Object Action: If you have an OLE object, use the drop-down box 

to choose the action. If you are not using an OLE object, this 
option is in gray mode. 

9. When you are done with the settings, click OK. 

 

● Edit an Action Button 
1. If you want to edit the action, select the button, shape, or image. Then, go 

to the "Insert" tab from the Ribbon and click the "Action” command from 
the Links group. 

2. Make necessary changes and click "OK". 
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● Test the Action Button in Your Slideshow 

1. Once you add your action button, you may now give it a try to make sure 
it works as you expect. 

2. Go to the slide containing the action button and select the "Slide Show" 
tab. 

3. Choose "From Current Slide" on the left side of the ribbon. 

4. You will then see your presentation starting with the slide containing the 
action button. 

5. Either click the button or hover your cursor over it, depending on the 
setup you picked in order to let you jump to the file or the slide that you 

linked to. 
 

 

3. Lesson Activity 

Instructions:  

1. Open the PowerPoint presentation with the filename: “My Link”. 

2. Insert an outline slide in the presentation, preferably after the Title slide. 

3. Insert a “Go Home” Action Button to all slides except the Title Slide 

(because this serves as your Home slide for this activity) 

4. Place the Home button at the lower left or lower right depending on your 

preference. 

5. Use “Mouse Over" so that when you hover your cursor over it, it will 

automatically lead you to the link without clicking the mouse. 

6. Insert a “Go Back or Previous” button to all slides except the Title slide. 

7. Place this button beside the Home button. 

8. Every time you click the Go Back button from each slide, it must lead you 

to the previous slide. 

9. Insert a “Go Forward or Next” button to all slides except the Title slide. 

10. Every time you click the Go Forward button from each slide, it must lead 

you to the next slide. 

11. Format and finalize your presentation. Make sure to apply the “7 Rules in 

Creating a Presentation” when finalizing the presentation. 

12. Save the changes you have made to the “My Link” file. 

 
 

 
 

 

 
 

 
 

 
 

 
 

Before you give the activity to 

the students, you must first 
discuss the following: 

1.   Activity Title: Using 
Action Button 

2. Materials needed: 

Computer and Microsoft 

PowerPoint presentation or 

other presentation software 

3. Objective: To create a 

presentation with action 

buttons 

4. Instructions 
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D. Making 
Generalizations 

DAY 4 
1. Learners’ Takeaways 

In this week’s lessons, I have learned that in order to create effective 
presentations I must do the following: 

_____________________________________________________________________________

_____________________________________________________________________________ 
_____________________________________________________________________________ 

_____________________________________________________________________________ 
_____________________________________________________________________________ 

_____________________________________________________________________________ 
_____________________________________________________________________________ 

_____________________________________________________________________________ 
 

 

 
2. Reflection on Learning 
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IV. EVALUATING LEARNING: FORMATIVE ASSESSMENT AND TEACHER’S REFLECTION NOTES TO TEACHERS 

A. Evaluating 

Learning 

1. Formative Assessment 

Instructions: 

1. Create an effective and professional-looking PowerPoint presentation 

using the topic that was given by your teacher. 

2. Your presentation must have at least 8 slides.  

3. It must also have a properly formatted Master Slide. 

4. Aside from text, images and shapes must also be placed in the 

presentation. 

5. Use animations and set the effects using the animation pane. 

6. Choose any of the text, image or shapes (at least 2 objects) and apply 

motion paths. 

7. Create an Outline slide (preferably after the Title slide) containing all the 

list of slide titles, in bullet form. 

8. Use Hyperlink to link the text in the outline slide to the slide containing 

the information. Do this to all the text (titles) in the Outline slide. 

9. Use also a Hyperlink to link a text or an image to a webpage and another 

text or image to link to an e-mail address. 

10. Insert a “Go to Home”, “Go Back”, “Go Forward” Action Buttons to all 

the slides except the title slide. These buttons must take you to the right 

slides of your presentation.  

11. Make necessary formatting and make sure to apply the “7 Rules of 

Creating a Presentation”.  

12. Save your work and use “Best Presentation Ever” as the filename. 

13. Be ready for an output presentation. 

2. Homework (Optional) 

The choice of topic could 

depend on you in order to make 
the activity more 

contextualized. It could be 
based on the current situation 

and activities of your class or 
the school, the community, 

locally or internationally.  

 
Choose the top 10 with the best 

output and you may require 
them to present in class. This is 

important so that other 
students may acquire new 

knowledge and skills from the 

model outputs. 

B. Teacher’s 
Remarks 

 

Note observations on 
any of the following 
areas: 

Effective Practices Problems Encountered 
The teacher may take note of 
some observations related to 

the effective practices and 
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strategies explored 
 

  problems encountered after 
utilizing the different strategies, 

materials used, learner 
engagement and other related 

stuff.  

Teachers may also suggest 
ways to improve the different 

activities explored/ lesson 
exemplar. 

materials used 
 

  

learner engagement/ 

interaction 

  

others   

C. Teacher’s 
Reflection  

 

Reflection guide or prompt can be on: 
▪ principles behind the teaching 

What principles and beliefs informed my lesson? 
Why did I teach the lesson the way I did? 
 

▪ students 
What roles did my students play in my lesson? 
What did my students learn? How did they learn? 
 

▪ ways forward 
What could I have done differently? 
What can I explore in the next lesson? 

Teacher’s reflection in every 
lesson conducted/ facilitated is 

essential and necessary to 
improve practice. You may also 

consider this as an input for 

the LAC/Collab sessions. 

 

 

 

 


